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I N T R O D U C T I O N

Welcome to Create Your
Own Website!



As the popularity of the Internet and the World
Wide Web have risen since the beginnings in
the early 1990s, virtually all businesses have
established an online presence. Many individu-
als, too, have left their imprints on the web,
creating a website for their family or posting
pictures of their vacations. If you want to join
the millions of people who have created websites
but fear you lack the background or expertise for
such an endeavor, this book is for you!

In this book you see just how easy creating a
website can be. The CD included with this book
contains professional website templates and a
free web page editor. With the web page editor,
you can quickly and easily customize the
provided templates into your very own
personal websites. Using the web page editor is
as simple as using a word processor program.
It’s just point and click!

Since there are a number of different types of
websites on the Internet, this book’s CD
includes templates for different types of sites.
Specifically, the provided templates let you
quickly create the following types of sites:

. Family websites—With a family website,
you can share pictures of you and your
family with friends and members of your
extended family.

. Hobby websites—A hobby website allows
you to share your hobbies with others who
have similar interests.

. Community websites—With a community
website, your church, club, bowling team,
or other group or association can post
information, schedules, pictures, and other
pertinent information.

. Online storefront website—Sell products
online by accepting credit card payments
with an online storefront site.
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In addition to showing you how to build your
own websites from the ground up, this book
includes chapters on how to use existing web-
based services to quickly create common
websites. Specifically, you’ll see how to

. Sell products at eBay Stores—eBay Stores
are a quick and easy way to start selling
products online. With eBay Stores, your
products are listed on eBay.com, and
payment processing is handled for you by
eBay. You simply list your products for sale
and ship them when purchased!

. Publish content online with a blog—A
blog is a type of website designed to allow
users to quickly and easily publish content
online. Blogs are springing up all over the
World Wide Web, used by both individuals
and businesses alike.

. Share your digital pictures—You’ve just
gotten back from your vacation to Tahiti
with gobs of digital pictures. How do you
easily share these beautiful pictures with
your friends and family? Digital picture
sharing websites make it easy to upload
your pictures and share them with select
friends and family.

. Create a home page on MySpace—
MySpace is one of many “social network-
ing” websites, where visitors can stay in
touch with friends, meet their friends’
friends, and make new social contacts. In
addition to maintaining and growing your
network of friends, MySpace makes it easy
for you to create your own web pages, post
pictures, share music, and host a blog.

. Share your videos on YouTube—With
today’s video cameras, it’s easy to upload
your home videos to your computer, where
you can watch or edit them. Once a video
is stored on your computer, you can upload
it to YouTube and share it with a world-
wide audience.



. Build your social network with
Facebook—Facebook is another popular
“social networking” website, like MySpace.
Unlike MySpace, Facebook allows users to
join one or more networks which are
organized by facets like geographic region,
employer, and school. It’s a great site for
catching up with old friends from high
school or college, as well as an excellent
resource for making new friends at your
company or in your neighborhood.

Whether you want to build your own, unique
website or use a pre-existing web application,
you learn everything you need to know to start
building your own website today with this
book. Get ready to see just how fun and easy 
it is to create your own website!
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C H A P T E R  1

Creating Your First Web
Page



Have you ever wanted to create your own

website but thought that the task was too

daunting? Do you think that only folks with

years of computer training and experience

have the knowledge necessary for building web

pages? These are common misconceptions that

many people have. With the right tools and

information, creating websites is as easy as

pointing and clicking! If you are interested in

quickly creating a professional-looking website,

then you’ve picked up the right book.
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in creating websites. Specifically, you learn

how to sell products through a website using

eBay Stores and publish content through a

blog at Blogger.com. You see how easy it is to

share photos and videos with friends and

family via Snapfish.com and YouTube. You

also learn how to get started with two popular

social networking sites: MySpace and

Facebook.

While there are literally millions of websites

available on the Internet, virtually all fall into

one of three categories:

. Family/Personal Website—Keep your
extended family and friends up to date
with the latest happenings of your family. 

. Online Storefront Website—Sell products
and services online! A great revenue
stream for home-based businesses.

. Content Publishing Website—Publish
your content on the World Wide Web. Be it
your poetry, your political or philosophical
views, or your hilarious home videos, by
distributing your content online, you open
it up to a potential worldwide audience of
millions. 

As you’ll see, creating websites that fall into

any of these three categories is a snap with the

provided templates and website tools. To get

started, all you need is this book, its CD, and

access to a computer with Internet connectivity.

“Creating websites is a snap with the
provided templates. To get started, all

you need is this book, its CD, and 
access to a computer with Internet

connectivity.”

NOTE
Don’t have website building experience? Don’t
worry! This book’s CD contains professional
website templates that you can use to build your
own website within minutes. You also learn how
to use existing website applications to sell prod-
ucts, publish content and videos, and share
images online.

This book includes a CD with website

templates, along with software for editing the

web templates. This chapter looks at the funda-

mental building blocks of websites and then

steps through the installation process of

SeaMonkey, the web page creation software

included on the CD. The next chapter exam-

ines the necessary steps to create a website 

and shows how to move the web page

templates from the CD to your website.

Chapters 3 and 4 illustrate how the templates

on the book’s CD can be customized to create

your own website. 

In addition to the website templates, Chapters

5 through 10 examine online tools that assist
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The Components of a
Website
In your experiences with the Internet, you’ve

likely visited several different websites. Some of

the more popular websites in terms of the

number of people who visit the site on a daily

basis include Yahoo.com, CNN.com,

Google.com, Amazon.com, eBay.com,

MSN.com, and others.

To visit a website, you must have an Internet

connection. Virtually all computers in places 

of business have an Internet connection, while

millions of home users connect to the Internet

through services provided by companies such

as AOL, MSN, EarthLink, or local cable or 

telephone providers.

Figure 1.1 shows a screenshot of Amazon.com’s

website when viewed through Internet

Explorer.

Notice that Figure 1.1 has the browser’s

Address bar circled. To visit Amazon.com

simply enter the domain name of the site—

www.amazon.com—into the browser’s Address

bar. That’s all you have to do.

Before you begin creating your own web pages,

it is vital that you know of the basic compo-

nents inherent to all websites. Specifically, all

websites are made up of the following three

components:

. A Web Server—A web server is an
Internet-connected computer whose sole
purpose is to provide a location for the
web pages of a website and to handle
incoming requests for these web pages.

. A Domain Name—A website’s domain
name is a unique identifier for a website,
much like your mailing address is a
unique identifier for your home. A
website’s domain name identifies the web
server on which the site’s web pages are
located.

. Web  Pages—A collection of files that
make up the content of a website.

NOTE
Companies that provide Internet connectivity—
such as AOL, MSN, and others—are commonly
referred to as ISPs, which stands for Internet
service provider.

Visiting a website from an Internet-connected

computer is a cinch. Simply open up a web

browser and type the domain name of the website

into the web browser’s Address bar.

NEW TERM
Each website has a unique domain name. To view
a particular website, a user simply types the
domain name of the website she wants to visit in
her browser’s Address bar. We’ll discuss the
purpose of domain names in more detail shortly.

www.amazon.com


Serving Web Pages with a Web
Server
All websites are located on a special type of

computer referred to as a web server, which is an

Internet-accessible computer that holds the

contents of the website.

When visiting a website through a web

browser, the web browser makes a request to the

web server that hosts that particular website.

The web server then returns the requested web

page to the browser. Finally, the browser

displays the web page, as shown in Figure 1.1. 

Figure 1.2 details this interaction from a high-

level view.

If the details of this interaction seem a bit

hazy, don’t worry; you don’t need to be

concerned about the specifics. For now, just
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realize that the contents of a website reside on

a remote computer that, like your computer, is

connected to the Internet. The browser obtains

the contents of the website you are visiting by

making a request to the site’s web server. The

web server returns the web pages being

requested, which are then displayed in the

browser.

Understanding Website Domain
Names
Did you know that there are literally millions of

websites in existence? To visit a particular

website from the list of millions, it is vital that

all websites be uniquely identified in some

manner. The way websites are uniquely identi-

fied is by their domain name.

F I G U R E  1 . 1

Amazon.com is displayed
in the web browser.
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A domain name is, ideally, an easily remem-

bered phrase, like eBay.com, Yahoo.com, or

CNN.com. All domain names end with some

sort of extension, which is a period followed by

two or more letters. Most domain names end

with extensions like .com, .net, or .org. Other

extensions are available, though.

Domain names provide a means to uniquely iden-
tify a website.

Web Pages, the Building Blocks
of a Website
Web pages are the atomic pieces of a website;

each website is a collection of web pages.

When visiting a website with a web browser,

what you are actually viewing is an individual

web page.

On a website, each web page is, in actuality, a

separate file. A file is a document that’s stored

on a computer. For example, if you use

Microsoft Word to write a letter to your

nephew, you can save the letter. This saved

letter is referred to as a file.

You can request a particular web page from a

website by typing the web page’s URL into a web

browser. You don’t have to type in a URL to view

a web page. As we saw earlier in Figure 1.1,

typing in just the domain name of a website

displays a web page as well. When typing in

just the domain name of a website, a specific

web page is automatically loaded—this page 

is referred to as the home page.

Getting Around a Website
A website is composed of a number of web

pages. Each web page is uniquely identified by

a URL. To visit a particular web page, you can

enter the web page’s URL in your browser’s

Address bar. However, as you know from

surfing the Web on your own, rarely, if ever, do

you take the time to enter a URL directly into

the browser’s Address bar.

An easier way to visit a particular web page is

by first loading a website’s home page, and 

then clicking on hyperlinks that take you to other

pages on the site. Hyperlinks are clickable

(1) You enter into
your web browser’s 

Address bar the
domain name of a

website...

(4) The returned 
web page is

displayed in the
web browser...

(2) The web browser sends
a request to that website’s
web server, asking to view
the website’s home page...

(3) The web server
sends back the

requested web page...

Index.htm

Web Browser
on Your Computer

MSN’s
    Server

F I G U R E  1 . 2

Visiting a web page
involves a request to a
web server.
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regions on a web page that, when clicked, whisk

you to some other, specified web page.

Think of a website as a book and a web page as a
page in a book. When visiting a website, you can
navigate through the various web pages, just like
when picking up a book you can flip around to
different pages. You navigate through the pages
of a book by thumbing through the pages; for a
website, you navigate through its web pages by
clicking on hyperlinks.

To demonstrate page navigation in a website,

take a moment to visit the website of the 

San Diego Chargers football team at 

www.chargers.com. As Figure 1.3 shows, this

website (like all websites) has a number of

hyperlinks. Along the top of the page, there 

are several hyperlinks to various sections of the

site: Schedule, Team, News, Charger Girls,

Tickets, and so forth.

Clicking the Schedule hyperlink whisks you to

a new URL—http://www.chargers.com/schedule/

schedule.htm—which is shown in Figure 1.4.

Notice that the Address bar in Figure 1.3 differs

from that in Figure 1.4. In Figure 1.3, the

Address bar reads http://www.chargers.com, the

domain name of the San Diego Chargers

website. After clicking on the Schedule hyper-

link, we were taken to a different URL. The

Address bar has been updated accordingly,

illustrating that we are viewing a different 

web page.

DOES YOUR WEBSITE LOOK RIGHT IN
EVERY BROWSER?

Webmonkey is a particularly good site for tuto-
rials on web building. We found a nice article
and chart on what standards different
browsers support. You may design and test
your website using the browser on your
computer. It may look fine to you, but what
about all of your visitors and the browsers
they're using? If you check out the browser
statistics on http://www.thecounter.com/
stats/, you'll find that 41% of people are using
Microsoft Internet Explorer 7.x, 37% are using
Internet Explorer 6.x, and 16% use Firefox.
That at least narrows it down for you when
you're trying to make sure your site can be
viewed properly by most people. If you want to
accommodate more people than that, pay
attention to the standards on Mozilla,
Netscape, Safari, and Opera, too.

IDEA GALLERY
http://en.wikipedia.org/wiki/Comparison_of_Web_browsers

www.chargers.com
http://www.chargers.com/schedule/schedule.htm
http://www.chargers.com/schedule/schedule.htm
http://www.chargers.com
http://www.thecounter.com/stats/
http://www.thecounter.com/stats/
http://en.wikipedia.org/wiki/Comparison_of_Web_browsers
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Figure 1.5 shows the interactions that take

place between the web browser and the

Chargers.com web server when first visiting the

Chargers.com home page, and then when

clicking on the Schedule hyperlink. (Again, if

you do not fully understand this interaction,

don’t sweat it!)

NOTE
If you visit www.chargers.com while reading this
book, the screenshots in Figures 1.3 and 1.4 may
be different from what you see on your screen.
That’s because, unlike a book, a website is
dynamic, allowing for its contents to be changed
easily.

F I G U R E  1 . 3

Visiting a web page
involves a request to a
web server.

www.chargers.com
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F I G U R E  1 . 4

The Schedule web page
is displayed.

Table 1.1 summarizes the core pieces of a

website.

Table 1.1 Key Website Building Blocks

Building Block Description

Web Server A web server is an Internet-accessible
computer that hosts one or more websites.
When viewing a web page, your browser
sends a request to the web server for the
specified URL.

Website A website is a collection of related web
pages.Websites have a bevy of purposes:
They can be used to share pictures, provide
information, or even sell products. Each
website is uniquely identified with a
domain name.

Building Block Description

Web Page A web page can have a mix of text and
graphics. A web page is like a single page in
a book.Web pages can be linked to one
another using hyperlinks, allowing the
visitor to quickly jump from one web page
to another.
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Knowing Your Options
There are two ways to leave your imprint on

the World Wide Web: Build your own website

from the ground up or use existing websites to

facilitate the process. If you want a truly

personal website with its own domain name

that you have complete control over the

appearance and content on the site, you want

to build your own website from the ground up.

This involves installing software on your

computer to assist with creating web pages and

(1) You enter the
domain name

www.chargers.com into
your web browser…

(4) The returned 
web page is

displayed in the
web browser...

(2) The web browser sends
a request to the Chargers.com

web server asking to view
the home page...

(3) The web server
sends back the

Chargers.com home page...

Index.htm

Web Browser
on Your Computer

Chargers’
Web Server

(5) You click on 
the Schedule
hyperlink...

(8) The returned 
web page is

displayed in the
web browser...

(6) The web browser sends
a request to the Chargers.com
web server asking to view
http://www.chargers.com/
schedule/schedule.htm

(7) The web server
sends back the

requested web page...

Schedule/Schedule.htm

Web Browser
on Your Computer Chargers’

Web Server

F I G U R E  1 . 5

Each time a new web
page is navigated to, the
web browser requests
the web page from the
web server.

requires using a web hosting company to host

your website. 

Alternatively, you can create a less personalized

website to share your content and keep in touch

with friends and family using any number of

web-based services. For example, you can sell

products online using eBay Stores or share your

vacation photos with friends and family using

Snapfish.com. 

www.chargers.com
http://www.chargers.com/schedule/schedule.htm


The benefit of using web-based services is that

they simplify the process of setting up and

configuring your website, whereas building a

website from the ground up requires more

effort. However, web-based services allow you

less control over the look and feel of your

website.

This book shows how to build websites from

the ground up as well as how to use various

web-based services. In this chapter and the

next, you see how to get started with building

a website from the ground up. Chapter 3 takes

the lessons learned in Chapters 1 and 2 and

looks at creating a family/personal website to

share your family’s latest news and photos

with friends and extended family. Chapter 4

shows how to build an online storefront from

the ground up.

Chapters 5 through 10 look at using web-based

services.

Building Web Pages Using
Web Page Authoring
Software Tools
Creating web pages is a simple task thanks to

specially designed web page authoring soft-

ware tools. These software tools allow you to

visually construct a web page with a few points

and clicks of the mouse. There are a number of

different software packages out there that are

designed to make creating web pages a snap.

Table 1.2 lists some of the more popular ones,

along with their price and a URL to learn more

about the product.
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Table 1.2 Popular Web Page Authoring Tools

For More 
Name Cost Information…

Adobe Dreamweaver $399.00 www.adobe.com/
products/dreamweaver 

Microsoft Expression $299.00 www.microsoft.com/
expression/

SeaMonkey Composer Free! www.seamonkey-
project.org/

As you can tell by their prices, Microsoft

Expression and Adobe Dreamweaver are

targeted toward the professional web developer.

They are both world-class products that make

building professional-looking websites an

absolute breeze. Unfortunately, the price point

for both of those products is a bit high for first-

time web developers (like yourself).

Fortunately, there is a good, free web page

authoring tool released by the open-source

Mozilla group, called SeaMonkey Composer.

NOTE
Mozilla is a not-for-profit organization estab-
lished in 1998. In addition to SeaMonkey, the
organization created and maintains a free
popular web browser called Firefox.

The CD accompanying this book contains

the SeaMonkey software, which includes a

web browser and a web page authoring tool,

among other utilities. To use SeaMonkey to

create web pages, you first need to install it

on your computer.

www.adobe.com/products/dreamweaver
www.adobe.com/products/dreamweaver
www.microsoft.com/expression/
www.microsoft.com/expression/
www.seamonkeyproject.org/
www.seamonkeyproject.org/
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JUST GIVE ME A TEMPLATE!

What if you're not creative? What if you have
no design education and experience? You still
want a nice looking website that attracts visi-
tors, and you have the skills to create it, but
you need the look—the typefaces, the colors,
the art. We just had to review Adam Polselli's
site again for this reason[md]he offers you an
array of choices from simple chic to corporate
to vintage and tells you step by step how to
get the particular look that you want. After you
read through his reasons for choosing
elements to achieve his theme, he lets you click
a link called “Putting It All Together,” where
you see a bulleted list of typefaces he recom-
mends, color schemes, shapes, borders, and
photo finishes so that you can duplicate his
design.

If you still want more than instructions to
achieve a look, you can buy HTML templates
from websites. Try sites like Boxedart.com and
designload.net, where you can buy full-page
templates or just buttons, art, and logos.

IDEA GALLERY
http://adampolselli.com/2001/11/03/get-the-look-vintage/

NOTE
The CD includes the most recent version of
SeaMonkey at the time of this book’s writing,
version 1.1.9. You may optionally download and
install the most recent version of SeaMonkey
from the official website—www.seamonkey-
project.org. If you do, though, realize that there
may be some slight discrepancies between what
you see on your screen and the screenshots in
this book.

Installing SeaMonkey
To begin the SeaMonkey installation, insert the

CD into your computer. This will launch a

program with three options:

. Browse Templates

. Install SeaMonkey

. Companion Website

Click the Install SeaMonkey option to begin the

installation process, which starts by displaying

the SeaMonkey Setup—Welcome dialog box

(shown in Figure 1.6).

www.seamonkey-project.org
www.seamonkey-project.org
http://adampolselli.com/2001/11/03/get-the-look-vintage/
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F I G U R E  1 . 6

The SeaMonkey installation welcome message.

Click the Next button to begin the installation.

The second screen is the Software License

Agreement screen, which provides the license

for use of SeaMonkey. After you have read and

agreed to this license, click the Accept button.

Doing so takes you to the third screen, the

Setup Type dialog box (shown in Figure 1.7).

The Setup Type screen lets you determine what

type of setup should be performed. Leave the

default choice—Complete—selected, and click

Next to continue.

F I G U R E  1 . 7

Choose to do a Complete installation.

The next screen asks you if you want to use

SeaMonkey’s Quick Launch option. Quick

Launch adds an icon to the Windows taskbar,

keeping SeaMonkey running even when you

close it. This provides quicker startup times

when you launch SeaMonkey. This option is

unchecked by default, and I would encourage

you to leave it unchecked unless you foresee

yourself using SeaMonkey regularly.

When you have decided on the Quick Launch

option, click Next to proceed to the final instal-

lation screen (shown in Figure 1.8). This final

screen provides a summary of the components

that will be installed. 
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When you are ready to begin the actual instal-

lation, click the Install button. Over the next

several minutes, SeaMonkey will be installed

on your computer. After it has completed

installation, SeaMonkey’s web browser auto-

matically launches and displays a welcome

web page. With SeaMonkey installed, we are

now ready to start using Composer, the web

page editing software we’ll be using through-

out this book.

F I G U R E  1 . 8

The final screen reviews the installation options.

Starting SeaMonkey’s Composer
After you install SeaMonkey, you are ready to

start using Composer, which is a tool for creat-

ing web pages. To use Composer, you must first

launch the SeaMonkey browser if it is not

running already. To launch the browser, go to

the Start menu, choose Programs, go to

SeaMonkey, and select SeaMonkey.

When the SeaMonkey browser starts, you can

launch Composer by going to the Window

menu in the browser and clicking on the

Composer menu item. Alternatively, you can

press Ctrl and the 4 key on your keyboard

simultaneously. Figure 1.9 shows a screenshot

of the SeaMonkey browser and the Window

menu.

After you select to launch Composer, the

Composer window should appear. Figure 1.10

shows a screenshot of the Composer window.

In the next section, we examine how to use

Composer to create a web page.

TIP
By installing SeaMonkey Composer, you are also
installing a full-fledged web browser. The
SeaMonkey web browser has many features not
found in Internet Explorer. I would encourage you
to try out the SeaMonkey browser—you might
just like it better than Internet Explorer! To learn
more about SeaMonkey’s features, check out
www.seamonkey-project.org/doc/features.

www.seamonkey-project.org/doc/features
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F I G U R E  1 . 9

Launch Composer by
selecting Composer from
the Window menu.

F I G U R E  1 . 1 0

The SeaMonkey
Composer window.
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Creating a Web Page with
SeaMonkey Composer
Creating web pages with SeaMonkey Composer

is as easy and intuitive as writing a letter using

a program such as Microsoft Word. Let’s look

at using Composer to build a simple web page,

one that provides information about some ficti-

tious individual. We start by entering the

content that we want to present in the web

page; we will come back and make the content

appear more eye-pleasing.

“Creating web pages with SeaMonkey
Composer is as easy and intuitive as

writing a letter using a program such as
Microsoft Word.”

To follow along, start Composer, if you haven’t

already. Recall that this can be accomplished

by launching the SeaMonkey browser, going 

to the Window menu, and choosing the Com-

poser option. (Refer to Figure 1.9 for a screen-

shot of the Window menu in the SeaMonkey

browser.)

Entering content into the web page is as simple

as typing it in! The web page we’ll be creating

is about a fictitious fellow named Bob. In this

page, Bob wants to share information about

himself, including

. His age

. What he does for a living

. A bit about his wife and kids

. His hobbies

. Information about his pets

Start out by typing in the information Bob

wants to share with the world. Feel free to be

creative and make up a bevy of interesting

facts about Bob to share in this web page. I

decided to enter the following for Bob:

Hello, you have reached my very first Web page! My name is Bob,
I’m 34 years old and I live in Dallas, Texas.

I work as an instructor at a sky-diving school, teaching people
how to jump out of planes. I’ve made over 400 jumps myself, and
made my first jump back when I was a mere 12 years old!

I am married to my wife Irene, and we have seven lovely chil-
dren: Bertha, Bobby-Joe, Jermain, Ted, Todd, Rod, and Lil’ Elaine.
Bertha’s the biggest and oldest, and Lil’ Elaine is the youngest
(although not the smallest—Rod has that distinction).

For fun I like to bowl. I am in a league, and we play every
Wednesday at the Bowlorama.

The joy of my life is my pet parrot, Mr. Polly. Mr. Polly has a large
vocabulary, and is quite talkative, especially when the whole
family sits down for dinner. Mr. Polly, believe it or not, has been
on several jumps with me.

Figure 1.11 shows Composer after I have

entered information about Bob.

Without a doubt, Bob’s first web page is a bit of

a disappointment. It doesn’t look very exciting.

Over the next several sections, we’ll examine

how Composer allows you to spruce up the

appearance of a web page. With a few simple

steps, you can radically improve the look and

feel of a web page.

NOTE
If you make a mistake when working with
Composer—be it choosing an incorrect color, an
incorrect font, mistyping, or whatever—you can
undo your last action by going to the Edit menu
and selecting Undo.
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WRITING FOR YOUR SITE

“The most valuable of all talents is that of
never using two words when one will do.”
—Thomas Jefferson

Writing for the Web by Jakob Nielson is an
older website but still offers relevant informa-
tion about writing styles and effective commu-
nications with people. Although not the most
attractive page, Jakob leads you to articles and
other places to reference style rules, usability
studies, and guidelines for writing different
kinds of text such as newsletters and press
releases, as well as tips on writing headlines,
subjects, and page titles that will get people's
attention.

IDEA GALLERY
http://www.useit.com/papers/webwriting/

Changing the Font
By default, the text you type into Composer is

displayed using the web browser’s default font.

You can choose a specific font quite easily in

Composer, though. To demonstrate this, let’s

have Bob’s home page displayed in the Arial

font.

Start by highlighting all of the text you’ve

typed in thus far. To highlight the text, you can

go to the Edit menu and choose Select All, or,

using the mouse, you can click and hold the

button within the text and drag the mouse

cursor to select a portion of the text. To change

the selected text’s font, go to the Format menu

and choose the Font option. This displays a

long list of available fonts, as shown in Figure

1.12. To follow along, choose the Arial font.

Figure 1.13 shows Composer after the font has

been changed to Arial.

NOTE
Most professional web pages are displayed in one
of three fonts: Arial, Times New Roman, or
Verdana. Figure 1.14 shows the same sentence in
these three different fonts.

http://www.useit.com/papers/webwriting/
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F I G U R E  1 . 1 1

Bob’s first web page.

F I G U R E  1 . 1 2

The Format menu’s Font
option lists the available
fonts.
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F I G U R E  1 . 1 3

The text in Bob’s web
page is displayed in the
Times New Roman font.

F I G U R E  1 . 1 4

Arial, Times New Roman, and Verdana are the three
most popular fonts.

TIP
To change the text for a portion of the document,
use the mouse to select just the text whose font
you want to change. Then go to the Format
menu’s Font option and select the font you want
to change the selected text to.

Making Text Bold, Italic, and
Underlined
You can make text bold, italic, and underlined

using the toolbar icons shown circled in Figure

1.15. To apply such formatting to a given piece

of text, highlight the text and then click the

appropriate icons.

For example, let’s have Bob’s children’s names

italicized. To accomplish this, use the mouse to

select Bob’s children’s names. When this text is

selected, simply click the Italic icon (the I in the

toolbar), and the text becomes italicized.

Also, let’s add a brief title before each para-

graph, where each title is made bold. Figure

1.16 shows Composer after the boldfaced para-

graph titles have been added and the children’s

names italicized.



CREATING A WEB PAGE WITH SEAMONKEY COMPOSER

23

TIP
You are not limited to making text only bold or
italicized or underlined. You can make text both
bold and italic, or both italic and underlined, or
any other combination of the three.

Changing the Colors
Composer allows you to easily specify the fore-

ground color for text, and the background color

for a web page. To set the foreground color,

simply select the text whose color you want to

change, and then go to the Format menu and

choose the Text Color menu option. Choosing

this option displays the Text Color dialog box,

which is shown in Figure 1.17.

F I G U R E  1 . 1 5

These toolbar icons allow
you to make text bold,
italic, and underlined.

F I G U R E  1 . 1 6

Some bold and italic
formatting has been
applied.
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This dialog box allows you to choose a color

from a palette of colors. After you select a color

and click the OK button, the dialog box closes

and the selected text’s foreground color changes

to the specified color. Take a moment to alter

the foreground color of some text in Bob’s web

page.

F I G U R E  1 . 1 7

The Text Color dialog box allows you to select the
text’s color.

The web page’s background color can be

changed by going to the Format menu and

choosing the Page Colors and Background

option. This displays the Page Colors and

Background dialog box (shown in Figure 1.18).

To change the page’s background color, select

the Use Custom Colors radio button and then

click on the Background button. This displays

the Text Color dialog box shown in Figure 1.17.

After choosing a color and clicking OK in both

dialog boxes, you are returned to Composer,

and the background color changes to the speci-

fied color.

F I G U R E  1 . 1 8

This dialog box allows you to change the background
color of the web page.

TIP
When specifying colors, be sure that the back-
ground and foreground colors contrast so that
the text is readable. If you choose a dark text
color on a dark background or a light text color
on a light background, visitors to your web page
won’t be able to read the text!

Some examples of bad color choices include
yellow text on a white background and blue text
on a black background.
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Positioning Text
Like with a word processor, Composer allows

you to position text in one of four ways:

. Left-aligned

. Center-aligned

. Right-aligned

. Justified

To specify the positioning, simply select the

text you wish to position and then choose the

appropriate positioning icon from the toolbar.

Figure 1.19 shows the text-alignment toolbar

icons circled.

To practice text positioning, take a moment to

right-align the paragraph titles (About Me, My

Job, and so on). To right-align the About Me

title, select the text and then click the right-

align toolbar icon. Repeat this process for all

paragraph titles on the page.

After the right-aligning has been performed,

your screen should look similar to Figure 1.19.

Saving the Web Page
There are many more formatting options in

Composer, and we examine these in detail

when we start building full-blown websites. 

The goal of the past few sections was to intro-

duce you to some of the more basic formatting

options Composer provides and to hammer

home the concept that formatting in Composer

is synonymous to formatting text in a word

processor.

FONTS, IMAGES, PHOTOS, AND
ILLUSTRATIONS FOR YOUR SITE

What if you want beautiful photos or illustra-
tions for your site, but you're not an artist?
Veer.com and plenty of other stock image sites
offer great deals on images.

We liked Veer because it also prints catalogs
and offer them in PDF format from its website.
The catalogs are works of art and can give you
some great ideas for how to use images and
type.

Here are a couple of tips to remember when
looking for a stock image:

1. Royalty-free images are your best buy.

2. If you want the same look to your website,
buy a CD of images that were designed to go
together.

IDEA GALLERY
http://www.veer.com/

http://www.veer.com/
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F I G U R E  1 . 1 9

These toolbar icons allow
for positioning of text.

“There are many formatting options in
Composer, and we examine these in

detail when we start building 
full-blown websites.”

Now that you have completed Bob’s first web

page, save it. To save the web page, go to the

File menu and choose the Save option. This

displays a dialog box prompting you for the

title for this web page.

All web pages have a title associated with them.

NEW TERM
The page’s title is displayed in the web browser’s
title bar when the page is visited.

Choose a title, such as “Bob’s First Web Page,”

and click OK. Next, you are prompted for

where to save the file. You can save it

anywhere on your computer you’d like, such as

in the My Documents folder, on the desktop, or

in a custom folder.

When saving the web page to your computer,

be sure to remove any spaces from the file-

name. While your computer can certainly store

files whose names contain spaces, URLs cannot.

Consequently, it’s good practice to omit spaces

from the filenames of your web pages.

At this point, the web page is saved only on

your computer. There is no way that your

grandmother in Toledo could visit this web

page through her web browser. To make this

web page accessible to anyone with an Internet

connection, we need to create a website and
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Summary
With the completion of this chapter, you’ve

taken your first step in your journey to create

websites. This chapter was a big first step,

covering many important facets of websites,

web pages, and web page authoring tools.

This chapter began by looking at the three

things all websites have: 

. A web server to return the requested web
pages to the requesting web browsers

. A domain name to uniquely identify the
website

. Web pages, which make up the building
blocks of a website

A web server is a computer where a website’s

web pages reside. It is this web server that is

queried when a user visits the website through

a web browser. The domain name is a unique

identifier for a website. To visit the home page

for a particular website, simply enter the

domain name in your web browser’s Address

bar. Finally, a website is composed of one to

then copy this file to the web server that hosts

our website. This involves a number of steps,

which are examined in detail in the next

chapter.

TIP
After you save a web page, you can open it for
further editing by starting Composer, going to
the File menu, and choosing the Open option.

many web pages. Each web page is, in actual-

ity, a file residing on the web server. Web pages

contain HTML markup that specifies how their

content should be displayed in a web browser.

In this chapter you also saw how to use

SeaMonkey Composer to create a simple web

page. Composer enables you to create and edit

web pages just like you would work with docu-

ments in any word processor program. Before

you can start using Composer, though, you

need to install the SeaMonkey software located

on this book’s accompanying CD.

In the next chapter, “Creating a Website,” we’ll

take a deeper look at the communication inter-

actions involved between a web browser and a

web server. We’ll also look at how to get started

creating a website, which involves finding a

web host provider and registering a domain

name. Finally, we’ll see how to upload web

pages from your computer onto your public

website’s web server. You find all this and more

in the next chapter
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Rename Album option, 137

Rotate and Flip option, 136

Select Photos screen, 133

sharing photos, 138

sharing photos, email addresses, 141

Store tab, 130

uploading photos, 132-135
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online shopping, process overview, 80-81

online shopping carts, 68

Add to Cart button, 67

configuring shipping costs, 74-76

customizing, 72

generating PayPal HTML, 73-74

sales taxes, 74-76

View Cart button, 67, 79-80

viewing, 79-80

online stores, eBay. See eBay

Only Members of this Blog option (Comments 
tab), 118

OpenID tab (Blogger), 115

ordering photo prints from Snapfish, 142-143

organizing your YouTube videos, 179

P

Paint Shop Pro, 39

passwords, blog creation, 106

PayPal, 64-65

Add to Cart button HTML

configuring shipping costs, 74-76

generating, 73-74

sales taxes, 74, 76

Merchant Accounts

creating, 67-69

Item ID field, 74

personal accounts

basic accounts, 70-71

creating, 71

Premier accounts, 71

Premier Accounts, creating, 68

percentage shipping costs, 76

Permissions tab (Blogger), 115

personal accounts (PayPal)

basic accounts, 70-71

creating, 71

Premier accounts, 71

personal information, sharing on YouTube, 180

phones (mobile), uploading photos to Snapfish
photo sharing service, 132

photo albums

adding to Facebook, 203-205

deleting, 137

rearranging, 137

renaming, 137

sharing, 138

Snapfish photo sharing service

deleting photos, 135, 137

editing photos, 132, 135

emailing photos, 133

ordering prints, 142-143

uploading photos, 132-135

viewing photos, 132

photo sharing services

choosing, 128

Snapfish

account creation, 129

Add a Border option, 136

Caption This Photo option, 136

Copy This Photo option, 137

Delete This Photo option, 137

deleting photos, 135, 137

Demo Album, 131

editing photos, 135
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emailing photos, 133

Home tab, 130

Move This Photo option, 136

ordering prints, 142-143

photo albums, editing photos, 132

photo albums, viewing photos, 132

Photos tab, 130

Rearrange option, 137

Remove Album option, 137

Rename Album option, 137

Rotate and Flip option, 136

Select Photos screen, 133

sharing photos, 138

Store tab, 130

uploading photos via computer, 132-135

photos

adding borders, 136

captioning, 136

copying, 137

deleting, 137

moving, 136

ordering prints, 142-143

rotating/flipping, 136

sharing, 138

email addresses, 141

uploading and sharing on MySpace, 158

Photos application (Facebook), 202

Photos tab (Snapfish photo sharing service), 130

pictures, adding to website, 161

pixels, 218

Polselli, Adam, 15, 107

positioning text, SeaMonkey Composer, 25

CREATE YOUR OWN WEBSITE 

Postal Service, 212-214

posting content to blogs, 111

Posting tab (Blogger administration page), 110

Premier Accounts (PayPal), creating, 68, 71

Premium Stores (eBay Stores), 88

privacy settings

Facebook, 198-200

MySpace, 161

product categories, naming (eCommerce website
template), 66

profile (Facebook), editing, 196-198

profile pages (MySpace)

name information, configuring, 157

customizing, 153-156

viewing, 151

promotional flyers (eBay Stores), 97

Publish tab (SeaMonkey), 39

publishing

blog entries, 113-114

Family/Personal website template, 59-
61

Publishing tab (Blogger), 115

purchasing items from eBay Stores, 97

R

Rearrange option (Snapfish photo sharing service),
137

receiving Facebook notifications, 201-202

Registered Users option (Comments tab), 118

registering domain names, 34-36
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Remove Album option (Snapfish photo sharing
service), 137

removing web pages from Family/Personal website
template, 55-56

Rename Album option (Snapfish photo sharing
service), 137

resizing digital images, 219, 221

resolution (monitors), 218

ROI calculator, 137

Rotate and Flip option (Snapfish photo sharing
service), 136

S

Sales Reports (eBay Stores), 101

sales taxes

Add to Cart button (Paypal), specifying
in, 74-76

eCommerce websites, 65

saving

blog customizations, 117

web pages in SeaMonkey Composer, 25

scanners, defining, 56

SeaMonkey Composer

downloading, 14

Family/Personal website template

adding bold/italic/underlined effects
to text, 54

adding/removing web pages, 55-56

changing fonts, 53

changing upper-left image, 48-50

customizing Family Pictures web
page, 56-57

customizing Family Pictures web
page, adding images to, 57-59

deleting upper-left image, 53

linking images to URLs, 52

publishing, 59-61

setting image/text alignment, 52

setting image/text spacing, 52

sizing images, 51-52

testing, 61-62

Image Properties dialog

Appearances tab, 52

Dimensions tab, 51-52

Link tab, 52

Location tab, 50, 58

installing, 15-17

launching, 17

Link Properties dialog, URL is relative to
page location check box, 61

web page creation, 19, 55

background color changes, 24

entering content, 19

font changes, 20-22

text color changes, 23

text positioning, 25

undoing actions, 19

website uploads, 37, 40

Search Engine Watch, 79

security, passwords, 106

Select Photos screen (Snapfish photo sharing
service), 133
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Sell page (eBay Stores), 93

Settings tab (Blogger administration page), 110

Archiving tab, 115, 120

Basic tab, 115

Add Your Blog to Our Listings?
option, 116

Show Compose Mode for All Your
blogs? option, 116

Show Email Post Links? option, 116

Show Quick Editing on Your Blog?
option, 116

Comments tab, 115

Registered Users option, 118

Anyone option, 118

Comment Notification option, 119

Only Members of this Blog option,
118

Users with Google Accounts option,
118

Email tab, 115, 121

Formatting tab, 115-117

OpenID tab, 115

Permissions tab, 115

Publishing tab, 115

Site Feed tab, 115

sharing

personal information on YouTube, 180

photos, 138

email addresses, 141

on MySpace, 158

shipping costs

Add to Cart button (Paypal), specifying
in, 74-76

flat costs, 76

percentage costs, 76

CREATE YOUR OWN WEBSITE 

shopping online, process overview, 80-81

shopping carts, 68

Add to Cart button, 67

configuring shipping costs, 74-76

customizing, 72

generating PayPal HTML, 73-74

sales taxes, 74-76

View Cart button, 67, 79-80

viewing, 79-80

Show Compose Mode for All Your blogs? option
(Basic tab), 116

Show Email Post Links? option (Basic tab), 116

Show Quick Editing on Your Blog? option (Basic
tab), 116

Site Feed tab (Blogger), 115

sizing

digital images, 219-221

Family/Personal website template
images, 51-52

Snapfish photo sharing service, 128

accounts

creating, 129

Add a Border option, 136

Caption This Photo option, 136

Copy This Photo option, 137

Delete This Photo option, 137

deleting photos, 135, 137

Demo Album, 131

editing photos, 135

emailing photos, 133

Home tab, 130

Move This Photo option, 136

ordering prints, 142-143
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photo albums

editing photos, 132

viewing photos, 132

Photos tab, 130

Rearrange option, 137

Remove Album option, 137

Rename Album option, 137

Rotate and Flip option, 136

Select Photos screen, 133

sharing photos, 138

email addresses, 141

Store tab, 130

uploading photos

via computer, 132-133

via email, 135

via mobile phones, 132

social networking sites, 148

Facebook, 188-189

friends, 188

friends, locating, 189-191, 194

home page, 194-195

networks, 189

notifications, receiving, 201-202

photo albums, adding, 203-205

Photos application, 202

privacy settings, configuring, 198-200

profile, editing, 196-198

MySpace. See MySpace

soft limits, 32

Standard account (YouTube), 169

Start Blogging arrow (Blogger), 109

starting SeaMonkey Composer, 17

stock images, 25

Store Categories link (Manage My Store page), 91

Store tab (Snapfish photo sharing service), 130

subscription level (eBay Stores), selecting, 88-90

Swish, 200

T

tax, sales tax, specifying in PayPal Add to Cart
button (PayPal), 74-76

templates (website)

eCommerce, 65

Add to Cart button, 67, 72-78

creating navigational links, 67

naming product categories, 66

online shopping process overview,
80-81

shopping carts, 67-68, 79-80

View Cart button, 67, 79-80

Family/Personal, 46-47

adding bold/italic/underlined effects
to text, 54

adding/removing web pages, 55-56

changing fonts, 53

changing upper-left image, 48-50

deleting upper-left image, 53

Family Pictures web page, 56-59

linking images to URLs, 52

publishing, 59-61

setting image/text alignment, 52

setting image/text spacing, 52

sizing images, 51-52

testing, 61-62
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testing Family/Personal websites, 61-62

text

color, changing in SeaMonkey
Composer, 23

entering in SeaMonkey Composer, 19

Family/Personal website template

adding bold/italic/underlined effects
to text, 54

changing fonts, 53

setting image/text alignment, 52

setting image/text spacing, 52

positioning in SeaMonkey Composer, 25

Text Color dialog, color changes, 23

titling

blog entries, 111, 116

blogs, 107

Traffic Reports (eBay Stores), viewing, 100

traffic trend analysis, 99

transfer limits

hard limits, 32

soft limits, 32

web host provider selection require-
ments, 32-33

U

underlined text effects, adding to text in
Family/Personal website template, 54

undoing actions in SeaMonkey Composer, 19

uploading

photos 

to MySpace, 158

to Snapfish photo sharing service,
132-135

CREATE YOUR OWN WEBSITE 

videos to YouTube, 171-173

web pages to websites, 37, 40

URL (Uniform Resource Locators)

blogs, selecting for, 107

Family/Personal website template

linking images to, 52

web pages, accessing, 9

URL is relative to page location check box (Link
Properties dialog), 61

user account (YouTube), creating, 169-170

usernames, creating on MySpace, 157

Users with Google Accounts option (Comments
tab), 118

USPS (United States Postal Service), 212-214

V

veer.com, 25

videos

embedding 

on a blog, 182-183

on your website, 181-182

YouTube

options, 172

organizing, 179

uploading to, 171, 173

viewing, 175

View Blog tab (Blogger administration page), 110

View Cart button (eCommerce website template),
67, 79-80
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viewing

HTML, 209, 211

photos, Snapfish photo albums, 132

profile pages on MySpace, 151

shopping carts, 79-80

Traffic Reports (eBay Stores), 100

videos on YouTube, 175

W

web browsers, 7

SeaMonkey Composer. See SeaMonkey
Composer

Web servers, relationship to, 8

web development

authoring tools

popular tool websites, 14

prices of, 14

SeaMonkey Composer

downloading, 14

installing, 15-16

launching SeaMonkey Composer, 17

web host providers

defining, 216

finding

ISP, 31-34

white pages websites, 30

selection requirements

disk space, 31

FTP support, 33

monthly transfer limits, 32-33

web logs. See blogs

web pages, 7, 9, 12

accessing

hyperlinks, 10

URL, 9

authoring tool websites, 14

creating in SeaMonkey Composer, 55

displaying, 8

Family Picture (Family/Personal website
template), 56-57

adding images to, 57-59

Family/Personal website template,
adding/removing from, 55-56

HTML, 208-211

hyperlinks, 10

linking, Family/Personal website
template, 56

navigating, 10

SeaMonkey Composer, creating via, 19

background color changes, 24

entering content, 19

font changes, 20-22

text color changes, 23

text positioning, 25

undoing actions, 19

URL, 9

web servers, 7

websites, uploading to, 37, 40

web servers, 7, 12, 27, 214

defining, 8

web browsers, relationship to, 8

weblogs. See blogs

website templates

eCommerce, 65

Add to Cart button, 67, 72-74, 76, 78

creating navigational links, 67
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naming product categories, 66

online shopping process overview,
80-81

shopping carts, 67-68, 79-80

View Cart button, 67, 79-80

Family/Personal, 46-47

adding bold/italic/underlined effects
to text, 54

adding/removing web pages, 55-56

changing fonts, 53

changing upper-left image, 48-50

deleting upper-left image, 53

Family Pictures web page, 56-57

Family Pictures web page, adding
images to, 57-59

linking images to URLs, 52

publishing, 59-61

setting image/text alignment, 52

setting image/text spacing, 52

sizing images, 51-52

testing, 61-62

websites, 12

accessing, 7

blog creation, 105

creation process overview, 30

domain names, 7

buying, 34

configuring, 36-37

extensions, 9

ICANN website, 34

registering, 34-36

templates, creating via, 41-42

videos, embedding, 181-182

CREATE YOUR OWN WEBSITE 

web host providers

finding, ISP, 31-34

finding, white pages websites, 30

selection requirements, disk space, 31

selection requirements, FTP support,
33

selection requirements, monthly
transfer limits, 32-33

web pages, 7-9, 12

accessing, 9-10

navigating, 10

uploading to, 37, 40

web servers, 7

West Elm, 142

white pages websites, 30

WhoIs, 59

width of digital images, 218-219

X-Y-Z

YouTube, 168

accounts, creating, 169-170

channels, customizing, 176-179

home page, 168

personal information, sharing, 180

videos

embedding, 181-183

options, setting, 172

organizing, 179

uploading, 171, 173

viewing, 175

Zuckerberg, Mark, 188
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